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Introduction

What are we creating?

Introduction – With Creation Crate 2.0 we will be making projects that not only build on your 
skills, but also build on each other.  This first project will show you how to use the ds3231 Real 
Time Clock module and a 7-segment LED Display.  In the coming months we will send you new 
components that will upgrade the project.  For example, next month you will learn how to add a 
buzzer, switch, and keypad to turn this into an alarm clock.  As your skills grow, your projects will 
grow!  Pretty cool, eh?

We will be making building and programming a clock using a 7-segment LED display and a 
digital timing chip, the ds3231.  Once the time is set, you will be able to plug in the clock and 
keep it powered after you disconnect it from your computer.  In addition, the ds3231 has its own 
battery, so if you lose power, it will keep up with the time and display it correctly again once the 
power is restored.

instagram.com/creationcrate

facebook.com/creationcrate

twitter.com/creationcrate
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Parts list

Other things you'll need
- Tape
- A sharp pencil or something to poke holes in the box.
- X-ACTO/ hobby knife or sharp scissors* Use only with adult supervision.  
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New electronic components

What will we learn making this project?

Real Time Clock (RTC) module
A real-time clock (RTC) is a computer clock, most often 
in the form of an integrated circuit, that keeps track of the 
current time.1  We are using the ds3231, but there are other 
popular chips, such as the ds3107 that basically do the 
same thing.  We can program the Arduino to keep track 
of time, too.  But the advantage of using the RTC is that 
it is dedicated to that one task, which frees up valuable 
resource on the microcontroller to do other things.  Other 
advantages include its low power consumption and the fact 
that it can have its own power supply that can keep the clock running even when the microcon-
troller is shut off.

We will learn about electronics:
- Using a “backpack” module to make it easier to control the 7-segment LED displays

And about programming:
- Using libraries
- Using two-wire communication (I2C)

If you ever get stuck, go to: www.creationcrate.com/uno-minuto
Password: GK2DJ7

TIP: Before you get started on your first project, depending on your ex-
perience level, you might want to check out some of our Getting Started 
videos available on our website www.creationcrate.com/classroom

Getting Started with Electronics
https://creationcrate.com/classroom/lesson-1

Getting Started with Arduino (hardware)
https://creationcrate.com/classroom/lesson-2 

Getting Started with Coding
https://creationcrate.com/classroom/lesson-3

Plus, an extensive Component Library 
https://creationcrate.com/classroom/component-library

Chris
Sticky Note
Random '1' here
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7-Segment LED display
a form of electronic display device for displaying decimal numerals that is an alternative to the 
more complex dot matrix displays.
Seven-segment displays are widely used in digital clocks, electronic meters, basic calculators, 
and other electronic devices that display numerical information. 1  
It gets its name from the seven individual segments (A-E in the diagram below) that are lit up by 
a series of LEDs behind them. 

This setup requires a wire for each LED for positive power, with a common ground. That’s a mini-
mum of 8 wires, 10 if you add the decimal point (DP).  When we scale that up to a display that 
needs to read four numbers, like our clock, that’s a LOT of wires!  Instead, we have a display that 
has been soldered to a “backpack” that can control all of them using just two wires.  

TIP: New to electrical circuits? You may want to watch the Getting Started with 
Electronics video in our Online Classroom. www.creationcrate.com/classroom 

Backpack Controller for 7-Segement Display
This consists of an I2C constant-current matrix controller chip that performs the task of send-
ing the proper signals to each of the LEDs that make up the display.  This makes it possible for 
us to control all of the segments of the display with just two wires!  (see: I2C / TWI Communica-
tion)

SCL

A0 A1 A2

SDA
GND
+5V

V_IO

SCL - 12C Clock Pin

SDA - 12C Data Pin

GND - negative

+5V - positive

V_IO - 12C bus voltage

Chris
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X-ACTO/ hobby knife or sharp scissors* Use only with adult supervision. 

Do the same thing on the front panel of the box.

It’s time to mount the 7-Segment Display to the front panel of the box.  Slide the display 
from inside the box.  Once it is in position, use a pencil to mark where the four holes are in 
the corners.  Remove the display and carefully poke a **small** hole from the inside of the 
box to the outside.  The holes are small, as are the mounting screws, so you don’t want to 
make the hole too big. 

Hardware assembly
1

2

3
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Push each of the four mounting screws through the front of the box and screw them into 
the nuts on the inside of the box.

One last thing to punch out and that is the hole in the back for the power supply.

4

5

OFFON

WAKE UP!!!

WAKE UP!!!WAKE UP!!!



08

Next, secure the breadboard and the UNO R3 in the bottom of the box using the two dou-
ble-sided tape squares.  The breadboard does have double-sided tape on the bottom, 
but next month you will replace this small board with a larger one.  It will be easier to 
remove this one if you use the smaller square.

1. Connect a 10mm jumper wire from the 5V pin to the bottom, red rail of the breadboard and 
the GND pin to the blue rail above it.  
2. Push the pins of the ds3231 module into the breadboard.
3. Connect a 20mm jumper wire from A5 to SCL and one from A4 to SDA
4. Connect 10mm wires from the VCC to the positive, red rail and the GND to the negative, blue 
rail

Now we are ready to wire up the components.  Below are schematic diagrams of where 
the wires are connected.  Grab some jumper wires and let’s get started by connecting the 
ds3231 module.  

6

7

Chris
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1. Connect a 20mm wire from the V_I0 pin to the 3.3V pin on the UNO R3
2. Connect the +5V and GND pins to the respective rails on the breadboard.  Use a 10mm wire 
for this and steps 3 & 4.
3. Connect the SDA pin to a hole in the breadboard in the same column as the SDA pin of the 
ds3231.
4. Finally, connect the SCL pin to a hole in the same column as the SCL pin of the ds3231.

Lastly, we need to wire up the 7-Segement Display. For this we will use the Female to Male 
jumper wires.

8

NOTE: Remember, the color of the wire you use does not matter. They all do the 
same thing.

Chris
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Function – A function is a block (or section) of code that is written to perform a specific task.

Class - A class is simply a collection of functions and variables that are all kept together in one 
place. These functions and variables can be public, meaning that they can be accessed by peo-
ple using your library, or private, meaning they can only be accessed from within the  class itself.

Serial Buffer –A place in your computer’s and microcontroller’s memory where information 
received in serial communication is stored until it is read by a program.¹

unsigned long - Unsigned long variables are extended size variables for number storage, and 
store 32 bits (4 bytes). Unlike standard longs, unsigned longs won’t store negative numbers, 
making their range from 0 to 4,294,967,295 (2^32 - 1). 

Char() - A data type that takes up 1 byte of memory that stores a character value. Character 
literals are written in single quotes, like this: 'A' (for multiple characters - strings - use double 
quotes: "ABC").

Characters are stored as numbers however. You can see the specific encoding in the ASCII 
chart. This means that it is possible to do arithmetic on characters, in which the ASCII value of 
the character is used (e.g. 'A' + 1 has the value 66, since the ASCII value of the capital letter A is 
65). 

struct – Data Structure - A data structure is a group of data elements grouped together under 
one name. These data elements, known as members, can have different types and different 
lengths.3  In our code, a structure has been created in the ds3231 library that we can use in our 
code to make it easier to compile all the variables to send and receive the time/date information 
to the ds3231 module.  This is the syntax: 

Syntax     Example
struct type_name {   struct ts t {
member_type1 member_name1;  t.sec = "00";
member_type2 member_name2;  t.min = setMinute;
member_type3 member_name3;  t.hour = setHour;
}      } 

Const - this keyword stands for constant. It is a variable qualifier that modifies the behavior of 
the variable, making a variable "read-only". This means that the variable can be used just as any 
other variable of its type, but its value cannot be changed.¹

Bool – a keyword that is short for Boolean.  A bool holds one of two values, true or false.¹

Terms

Commands

New coding commands/concepts

Chris
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unsigned long - Unsigned long variables are extended size variables that are used for storing 
numbers.  They store 32 bits (4 bytes). “Unsigned” means that it does not store the sign and 
thus will only store positive numbers.¹

while - A while loop will loop continuously, and infinitely, until the expression inside the paren-
thesis, () becomes false. Something must change the tested variable, or the while loop will never 
exit. This could be in your code, such as an incremented variable, or an external condition, such 
as testing a sensor.¹

Void – You’ve already learned the two main void functions that you need for a sketch, void 
setup () and void loop ().  But did you know that you can create your own functions that can be 
called from other places in the code as needed?  In this project, we will be calling void send-
Time () – which will be used to do just what it says – send the time information to the chip.  We 
set this up as a separate function outside of the loop as we don’t need this to execute over and 
over.  We only need it to run when we want to change the time on the ds3231 module. 

Citations: 
¹www.arduino.cc  |  ²www.wikipedia.com  |  3cplusplus.com

New Libraries

A word about libraries.  Try to think of a code library like this:  In my brain (computer) I have a 
certain amount of information and I understand how to complete a certain number of tasks.  
If I want to learn something new, I can go to the library and fill my brain (computer) with new 
information that will allow me to complete new tasks.  A library for your code is very similar.  
The Arduino IDE “knows” a certain number of commands and can perform a certain number of 
functions.  A library is essentially another sketch containing new commands that can be used to 
interface with new components.  Not only does it allow you to do cool, new things with them, it 
also simplifies their use by packaging up complex functions into commands that are simple to 
use and easier to understand.  For example, the specifications sheet for the ds3231 is 20 pages 
long (https://datasheets.maximintegrated.com/en/ds/DS3231.pdf).  It provides a schematic, 
technical specifications, and data formats that can be used to communicate with the integrated 
circuit (IC).  The library takes all of that information, bundles up all of the tedious tasks, like pars-
ing (separating) the data string and giving the parts names like sec, min, and wday.

Wire.h – Two Wire Communication (I2C) - This library allows you to communicate with I2C / 
TWI devices. On the Arduino boards with the R3 layout (1.0 pinout), the SDA (data line) and SCL 
(clock line) are on the pin headers close to the AREF pin. The Arduino Due has two I2C / TWI 
interfaces SDA1 and SCL1 are near to the AREF pin and the additional one is on pins 20 and 21.

https://www.arduino.cc/en/Reference/Wire
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TIP: New to writing code? You may want to watch the Getting Started with 
Coding video in our Online Classroom.  www.creationcrate.com/classroom 

As you are typing in the code below, keep a few things in mind:
- The Arduino IDE allows the rows to be much wider, so some of the text below wraps around, 
but it does not need to.  Just pay attention to the line numbers.
- The colors we use below are to help make it easier to read and understand, but they are differ-
ent than what you will see as you type your code.
- You do not need to type in all of the //comments.  Only type the ones you think you will want to 
have for reference and any of your own.

Writing the code

ds3231.h – Real Time Clock – We are using a library created by Petre Rodan.  The ds3231 can 
do a lot of things besides just keep time.  It can store alarm times and signal when an alarm 
should be triggered and it has a thermometer on board to help adjust the timing by compensat-
ing for temperature variations.  With the library, we can easily access and use all of the functions 
available.

Adafruit_LEDBackpack.h – Using 7-segment displays are fairly simple as we only need to 
control a few LED lights by turning them on and off to represent numbers and letters.  However, 
the number of pins needed to control each of the LEDs can grow unmanageable very quickly 
as you add more segments.  The backpack consists of an IC that has assigned an address to 
each of the LEDs in the matrix and can turn them on individually based on the data being sent to 
it from the UNO’s Serial Data (SDA) pin, and kept in sync by the Serial Clock (SCL) pin.  Adafruit 
developed this library, which has a Creative Commons license with an attribution (to give credit 
to) clause.  Meaning it is free to use, modify, and share as long as you make sure you give prop-
er credit to them for the work they’ve put into it.

 1.   /*--Code Libraries for this Project--*//
2.   #include <Wire.h>
3.   #include "ds3231.h"
4.   #include <Adafruit_GFX.h>
5.   #include "Adafruit_LEDBackpack.h"
6. 
7.    /*
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8.    * Here we are creating an instance of the Adafruit_7segment class so 
9.    * it can be used in our code.  We also assigned it to the variable 
10. `* 'matrix', which is  what we will call it in our code.
11.  */z
12. 
13. Adafruit_7segment matrix = Adafruit_7segment();  
14. 
15.  /* -- Pin assignments -- */
16. #define BUFF_MAX 128             //The default buffer size is 64 bytes, here we are   
      increasing it to 128
17.  int convertedTimeHour = 0;        //Converted clock hour based on 12-hour format.
18. 
19. /* -- Clock Time Variables -- */
20. /* 
21. timeSetFlagMode is used for setting both the alarm & time hour & minute. When true 
22. it indicates that alarm hour and minute are set and can be sent to the ds3231.  Set it 
23. to 'true' to set the clock.  Then after you upload the code and the time is set, change 
24. it to 'false' and upload it again.  This will prevent the program from overwritting the 
25. time if it is restarted or loses power.  Since the ds3231 has its own battery, the clock 
26. will keep running even when the power to the UNO R3 is off.
27. */
28. bool flagSetTimeMode = true;  //indicates that entry into the clock/alarm time set      
      mode is permitted.
29. bool timeSetFlag = true;          //this flag will determine whether or not we can set the    
      time
30.
31. //Next month we use a 4 button membrane switch to set the time.  To get started, just    
      enter the time/ date here:
32. int setHour = 1;                 //enter the hour in military time (0-23) (add 12 if after 12pm,  
      e.g. 2pm = 14)
33. int setMinute = 17;            //enter the minute
34.  int setSecond = 0;     //enter the second (optional
35. 
36. //The Date information is not necessary, but adding it will allow the clock to recognize   
      Daylight Savings Time changes
37. int setDOW = 5;                 //enter the Day of the Week (Monday = 1, Sunday = 7)
38. int setDay = 11;                  //enter Day or leave as default: 1
39.  int setMonth = 5;                //enter Month or leave as default 1
40. int setYear = 2018;            //enter Year or leave as default 2018
41. 
42. /* -- Display Clock Time --*/
43. bool blinkColon = false;        //records the state of the colon in quad-7 segment dis  
      play.
44. int tcurrent = 0;                     //used to store the current second in order to blink the    
      colon properly.
45. int timeHour = 0;                  //used to store the Hour from the DS3231 chip.
46. int timeMinute = 0;               //used to store the Minute from the DS3231 chip.
47.       int timeSecond = 0;              //used to store the Second from the DS3231 chip.

Chris
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48.
49.
50.

51.

52.

53.
54.
55.
56
57.

58.

59.

60.
61.
62.
63.
64.
65.

66.

67.
68.
69.
70.
71.

72.
73.
74.
75.
76.
77.
78.
79.
80.
81.

 
 /* -- DS3231 Information -- */
 char recv[BUFF_MAX];              //defines variable 'recv' as an array [] of characters,    
'char', with up to 128 bytes, 'BUFF_MAX' (defined in line 16)
 unsinged long prev;        //stores the last time we received the time from the 
ds3231 module
 int interval = 1000;          //sets the time, in milliseconds, between requests sent to 
the ds3231 module
 
 void setup() 
 {
   Wire.begin();                   //initiate the wire library for the two-wire communication
 matrix.begin(0x70);         //assigns an address to the I2C device, in this case the 
7-segment display
  DS3231_init(DS3231_INTCN);      //sets up the IC on the communication bus - (what 
is this parameter) - initializing/ configuring I2C communication to the DS3231
   memset(recv, 0, BUFF_MAX);      //clear the memory - format is: memset(variable, 
value, sizeof(data)), here: (variable='recv', value=0, length=128 bytes)
 }
 
 void loop() 
 {
   /* -- Set the Clock Time -- */
 while (flagSetTimeMode == true) {   //allows time updates only when we have 
entered the set time mode.  next month we add a button for this.
 timeSetFlag = true;               //this flag will be used until next month when you will   
learn how to set the clock using a 4 button input
 break;                            //Ends the while command
 }
 
 if (timeSetFlag == true) {
 flagSetTime   ode = false;   //Set this back to 'false' in order to exit the set time 
mode.
 timeSetFlag = false;            //Same as above
 
 sendTime();                        //here we are calling the function in 145 of the code.
 }
 
 /* -- END: Set the Clock Time -- */
 
 /* -- Retrieve the current time stored in DS3231 Chip --*/
 unsinged long now = millis();          //The variable, 'now', is the current time
 struct ts t;                           //Declare the variable 't' so we can retreive the 
time/ date information from the ds3231 module
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82.
83.
84.
85.
86.
87.
88.
89.

90.
91.
92.
93.

94.

95.
96.

97.
98.
99.
100.
101.
102.
103.
104.
105.
106.
107.
108.
109.
110.
111.
112.
113.
114.
115.
116.
117.
118.
119.
120.
121.
122.
123.
124.
125.
126.

   /*
 * We don't need to retrieve the time from the ds3231 as often as the applicaiton 
 * will allow.  Below we check to make sure a certain amount of time has passed, 
 the 'inverval', which was declared in line 50, before we send the next request. 
 */
 if ((now - prev > interval) && (Serial.available() <= 0)) 
 {
 DS3231_get(&t);                     //Here we will receive the current time/ date in the 
structrured format (TssmmhhWddmmyyy)
 prev = now;
 }
 
 timeHour = t.hour;         //Retrieves the current clock hour and stores into global  
variable.
 timeMinute = t.min;       //Retrieves the current clock minute and stores into global 
variable.
 
  timeSecond = t.sec;     //Retrieves the current clock sec and stores to global 
variable
 /*
 * We are only sending "numbers" to the LED Display, not a "time"  We will receive 
 * the hours and seconds as two digits each, so we need to format it so it can be 
 sent to the display. 
 */
 int currentTime = t.hour * 100 + t.min; //Display the time on 7-segment display
 
 if (t.hour > 12)                       //Subtracts 12 from hours more than 12.
 {                    
 currentTime -= 1200;
 convertedTimeHour = t.hour - 12;
 }
 else if (t.hour == 0)                //Adds 12 to clock hours equal to zero.
 {
 currentTime += 1200;
 convertedTimeHour = 12;
 }
 else 
 {
    convertedTimeHour = t.hour;
  }
 
 matrix.print(currentTime);
 if (t.min < 10) {
 matrix.writeDigitNum(3, 0);
 }
 if (t.sec != tcurrent) 
 {
 blinkColon = !blinkColon;       //Allows colon between the hour & minutes to blink 
ON and OFF for approximately 1 second each.
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127.
128.
129.
130.
131.
132.
133.
134.
135.
136.
137.
138.
139.
140.
141.
142.
143.
144.
145.
146.

 tcurrent = t.sec;
 }
 matrix.drawColon(blinkColon);
 matrix.writeDisplay();
 }
 
 //this is a function that puts the time/date elements together so they can be sent to 
the ds3231 module
 void sendTime() 
 {                   
 struct ts t;                      //struct ts is a data type that is defined in the ds3231 library
 t.sec = setSecond;
 t.min = setMinute;
 t.hour = setHour;
 t.wday = setDOW;
 t.mday = setDay;
 t.mon = setMonth;
 t.year = setYear;
 DS3231_set(t);                    //passes all of these numbers to the DS3231 module.
 }

Almost there - Testing
Now that you’ve entered the code, it’s time to see if it works!

1. Connect your Uno R3 board to your computer with the USB cable provided.
2. Navigate to ‘Tools > Port’ and select the port connected to your Uno R3. (If you have trouble 
finding the right port, try disconnecting other USB devices).
3. Navigate to ‘Tools > Board’ and select “Arduino/Genuino Uno”
4. Navigate to ‘Sketch > Upload’. You should see this at the bottom:

(If the program doesn’t upload and you see error messages, don’t worry! Errors are very com-
mon when coding- I’d be more surprised if you didn’t have any! See the next page for possible 
solutions).
5. Your project should now be working!
6. Now see if you can solve the exercises on page 18 to test your new skills and understanding 
of the project.
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Troubleshooting
Code

Typos - The words have to be exacty! MAkure sure your code matches the code in this 
booklet. Note: Letters are case-sensitive.

Missing ';' - Any time you write a line of code, it has to end with a ';' (semicolon). The only 
exceptions in this code are lines that start with 'void', 'if', 'else', or 'for'.

Missing/extra brackets - Any time you use an opening bracket '(' or '{', you must have a 
closing bracket to match it ')' or '}'. Having too many brackets will also create errors. Lastly, 
make sure these are placed correctly!

These are the most common programming errors:

1

2

3
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If your project is not working, the first place to start is to make sure that the  wiring is correct.  
Here are some common mistakes:

The most common error is to reverse the LED leads.  Ensure that the shorter lead is con-
nected to the negative (blue) and the longer lead is connected to the positive (red) rail on 
the breadboard.

Make sure you have the red power rail connected to 5V and the blue power rail con-
nected to GND from your UNO R3. Also make sure all the components are going to the 
correct rails.

Make sure all the wires that are supposed to be connected are in the same column.

TIP: Instead of having to disconnect the jumper wires to see 
which is longer, if you look closely inside the LED you can see 
that the large tip is the positive and small tip is the negative. 

Circuits

1

2 3

1

2

3

(-)(+)
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Can you make the clock display times in two different time zones?  Alternate the time displayed 
on the clock to periodically display the time from another time zone. 

Hint: One way is to set up a delay in between the current function displaying the time and an-
other function that will add (or subtract) a certain number of hours.

When you’re done, share some pictures and your answer(s) with the Creation Crate Community 
on Facebook and Instagram.

Exercise #1: Change the brightness of the LED display.  The documentation says that we can 
display brightness with a value between 0 and 15.Write down what additions to the code you 
came up with and where you placed it in the sketch. 
Can you figure out how to make this work?

Hint 1: There is a routine built into the library called: setBrightness()
Hint 2: Remember that we renamed the Adafruit_7segment to ‘matrix’ and a similar routine that 
we used in the code is called ‘drawColon()’  You will need to follow the same pattern that we use 
to light up the colon, including the command that actually writes the new value to the display.

Exercise #2: During the day the display needs to be bright, but at night that can be annoying.  
So, now that you know how to change the brightness, can you make it so the brightness chang-
es at a certain time of the day?  

Hint: You may want to declare two variables at the beginning that you can set as the time for 
a bright display and a time for a dim display.  Then you can compare the current time with the 
variables you set to determine which setting to write to the display using an if statement.

Monthly challenge

Exercises
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For help with drivers, instructions, code, etc., please visit our support page: 

If you ever get stuck, go to: www.creationcrate.com/uno-minuto
Password: GK2DJ7

Still Need Help?  
Visit https://www.creationcrate.com/contact-us 

Sneak Peek
Can you guess what next month’s project is?
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Notes
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